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Getting Started
This section outlines the basic steps for operating the Dveous/MX. You may 
also find it helpful to work through the examples in this section. By doing this 
you can familiarize yourself with the Control Panel and some basic operations. 
Unless otherwise noted the operation is the same in either SD or HD mode.

This section is divided into the following parts:

• Powering Up – how to turn your system on. How to deal with having several 
Control Panels plugged into your system.

• Selecting Formats – how to switch your Dveous/MX between SD and HD 
operations.

• Selecting Sources – how to select external and internal inputs, and assign 
Near/Far designation for the channel(s). Also, how to invert, freeze and soften 
the source video.

• Adjusting Input Sources – how to fine tune your inputs: inputs with different 
aspect ratios, blanking width compensation and motion detect.

• Delegating Channels – what is delegation and how to do it.

• Copying Channel Settings – copying information across channels.

• Channel Configuration – how to assign one of the three processing modes 
(video+video, video+key or video-key+shadow) to the twin (B) channel.

• Getting Back to Default – using the CLEAR and NORMAL buttons to reset 
the system.

• The Numbering System & Numeric Keypad – understanding how numeric 
values affect your image and how to use the numeric keypad functions.

• The Joystick – full details on operating the joystick, plus a few cool tricks.

• Creating a Simple Effect – step by step instructions. Plus how to read the 
LEDs on the menus buttons.

• Modifying an Effect – step by step instructions.

• Saving Effects – overwriting and recalling effects.

• The Effects Menu – using the RECALL EFFECT button to name and delete 
effects, browse the effects register and set Loop and Protect flags.
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Powering Up
This section assumes that your Dveous/MX system is properly installed and 
configured. For details on installation and engineering configuration, see the 
Dveous/MX Technical Guide, P/N 9100-0402-00. 

1. The main power switch is located in the back of the Chassis toward the cen-
ter on the right side. Push the switch toward the “1” to turn it on. 

When you power up Dveous/MX, channel 1A appears full size at the video 
output, with input 1 as its source video. The key output is a full raster white 
field that duplicates the size of the transformed source video. You can 
change this default by reconfiguring the channels, as described later in this 
section.

2. If the cable connecting the Chassis to the Control Panel is less than 33 ft. 
(10 meters), the Control Panel can get its power from the Chassis, and boots 
up at the same time as the Chassis.

If the Control Panel cable is more than 33 ft. (10 meters) long, you need an 
external power supply for proper operation. The external supply (Abekas® 
P/N 2800-0063) DIN connector plugs into the Control Panel connector 
labeled “POWER.” The external supply AC cord then plugs into a standard 
AC Mains socket to power the Control Panel. (The external power supply is 
autoranging, accommodating 90 to 264 VAC at 47 to 63 Hz.) 

3. When both the Chassis and Control Panel are powered up and running, the 
local 3D Trans menu appears in the Control Panel display.

Note: If the Chassis and Control Panel are not communicating, the menu display either 
remains blank or displays the message: “No chassis detected, check power and cable”. If this is 
the case, check the cable connection at both the Control Panel and the Signal Chassis.

Note: Also be aware that the message: “No chassis detected, check power and cable” appears 
during bootup. This is normal.

4. If a single Control Panel is connected to the Chassis, its ACQUIRE button 
LED lights automatically. 

Dveous/MX is now ready to use. See the discussions in this section for informa-
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tion on input and output setups, channel configurations, and creating simple 
effects.

Powering Up Multiple Control Panels
If there is more than one Control Panel connected to the Chassis, you must 
make one the dominant Control Panel. This procedure is performed by first un-
acquiring all the Control Panels, then acquiring the dominant one and saving 
this configuration in the Engineering menu. This way, each time you boot up 
Dveous/MX, the dominant Control Panel always has control.

1. Press ENG to go to the Engineering menu.

2. Unacquire all the Control Panels: Press and hold ACQUIRE on each 
remaining Control Panel. The Chassis menu function appears in the menu 
display.

3. While holding ACQUIRE, toggle the Chassis softkey so that Chassis is not 
highlighted in black. All Control Panels are now unacquired.

4. Acquire the dominant one: Press and hold the ACQUIRE button on the 
Control Panel you want to be dominant. The Chassis menu function appears 
in the menu display.

5. While holding ACQUIRE, press the Chassis softkey so that Chassis is high-
lighted in black. The Control Panel is now acquired and its ACQUIRE but-
ton is lit.

6. Press Setup and toggle it to Panel. Ensuing unacquire and acquire commands 
will now be remembered for bootup.

Temporarily Changing Dominance of a Control Panel
If you temporarily want to make another Control Panel the dominant one, sim-
ply un-acquire the current dominant Control Panel and acquire the new one.
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Selecting Formats
Dveous/MX can operate in either SD (Standard Definition) or HD (High Def-
inition) Mode. Once the machine is configured it will remember the settings 
and always boot back to that mode unless changed.

Note:  At factory shipment or after a First Birthday (see section 3 of Dveous/MX technical 
guide, P/N 9100-0402-00, for more information on First Birthday) the machine will boot up 
to SD Mode.

To change the format, go to the Output Setup Menu and using the config soft-
key select (highlight) either SD or HD. When you have changed the format 
you will be prompted with the following message: "chassis reboot required to 
change format from SD to HD". You must now power cycle the main power 
on the chassis.

After the power cycle, Dveous/MX will boot up to the selected format and auto-
matically change the aspect ratio to 1 x .75 for SD or 16 x 9 for HD. You must 
now return to the Output Setup Menu, highlight the Config softkey and, using 
the D softknob (Format), select the particular format of SD (525/625) or HD 
(720, 1035, 1080),

You must also be sure that the reference and all inputs match the selected format 
and frame rate. Dveous/MX is now ready to operate in your selected SD or HD 
format.
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Selecting Sources
Dveous/MX has either 6 or 12 source inputs and up to four independent DVE 
channels in HD mode and always has four independent DVE channels in SD 
mode. An internal 16 input by 11 output crosspoint matrix lets you route all 
internal video, key, and texture signals.

External inputs are all available as DVE channel sources. Internally generated 
channel sources are the SuperMatte (color background) generator, the output of 
the Pattern Framestore, and the outputs of the wide range Defocus module. 
Since the Defocus module is dual channel, you have a total of 10 available 
sources in a Dveous/MX system (16 with the second input module option 
installed).

You can select any source as an input to any of these internal destinations: the 
four DVE channels (if dual twin system), the texture processors associated with 
each channel, the Background Framestore, and either input of the dual channel 
Defocus module.

Selecting a Channel Input  Each DVE channel has a “near” and a “far” side. 
You can select a different source for each side, or you can send the same source 
to both. The near side is always the one you can see; the far side is always the 
one you cannot see. No matter how many times you rotate the DVE, you are 
always looking at the near side. In live situations, the far side can be used to pre-
select the next source to air.

SOURCE
Near Far

FREEZE

BLUR

SOURCE INVERT

1 Off

JP JP
KEYPAD

INPUT Ch 1A
CURRENT TIME:        0:00  CURRENT EFFECT: WorkSpace    EFFECT KFs:

KF# TYPE

Gb
1A
1B
2A
2B

SOURCE INVERT

TYPE
Video

SuperMatte
Pattern

Defocus A
Defocus B
Aux Bus
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1. Delegate the channel for the source input by double pressing a Channel 
Select button (1A, 1B, 2A or 2B.) Make sure only one channel is delegated 
(unless you want to route the same video to multiple DVE channels.)

2. Press INPUT in the Channel Menu buttons to bring up the Input menu.

3. Toggle the Source softkey to Near to select a source for the near side of the 
channel. The Type, Source and Invert softknobs appear.

4. Use the Type softknob to select one of six source modes: Video lets you select 
one of the 12 external inputs using the Source parameter. Pattern brings in 
the output of the Pattern Framestore. SuperMatte selects the SuperMatte 
generator. Defocus A and Defocus B input the corresponding output of the 
Defocus module. Aux Bus enables the XPNT parameter, which lets you 
select the crosspoint from an external switcher auxiliary bus.

You have now performed the basic steps to select source video. If you wish, 
you can further define source characteristics. The steps below will tell you 
how to invert the video, freeze it and soften it.

Inverting, Freezing and Softening the Source Video  

1. Invert the source image horizontally, vertically, or both. The Invert softknob 
is Off by default, giving the image normal orientation. H inverts the video 
horizontally, V inverts the video vertically, and H+V inverts the image in 
both directions.

2. Freeze or strobe a source in the channel, by pressing the Freeze softkey to 
bring up the Mode and Strobe softknobs.

The Mode softknob selects the freeze mode: Off (no freeze, i.e., live video); 
Fld 1 (freezes field one of the input video); Fld 2 (freezes field two of the 
input video); or Frm (freezes the full frame of the input video).

The Strobe softknob lets you freeze the image indefinitely (Infinity), or cre-
ate a strobe effect. To create a strobe effect, select the freeze duration, 
between 0-254 frames, with the Strobe softknob. Dveous/MX holds the fro-
zen image for that duration before grabbing the next freeze. For example, 
with a freeze set to strobe every 10 frames, Dveous/MX freezes and holds an 
image for 10 frames, grabs a new image and freezes it for 10 frames, and so 
on.

3. Without using the Defocus feature, you can soften the source image to a cer-
tain extent. Press the Blur softkey to adjust the horizontal and vertical blur 
settings. The default is 0 (no blur); 100 gives the maximum blur.

4. Toggle the Source softkey to Far and repeat steps 4 through 7 for the far of 
the channel.
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5. Toggle the Source softkey again to highlight both Near and Far if you wish 
to have the same image on both sides.

Note: With a freeze enabled on a channel, you cannot see new sources as you select them. Also, 
with a freeze enabled, the same video appears on both the near and far sides of the channel.
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 Adjusting Input Sources
The following pages cover source adjustments concerning

• Different aspect ratios using Anamorph

• Blanking

• Motion detect

Inputs with Different Aspect Ratios
Normally, Dveous/MX expects input video to use the 16:9 aspect ratio if work-
ing in HD and the 1 x .75 (4 x 3) aspect ratio if working in SD. However, if 
you are using video with a different inherent aspect ratio, you can change the 
expected aspect ratio of Dveous/MX to allow internal transforms, warps, crops, 
etc. to match the specified aspect ratio.

To change the aspect ratio, go to the Personality menu. Press the Anamorph 
softkey and adjust the H and V softknob, then press Anamorph again to con-
firm. For example, with an aspect ratio of 4x3, change H = 4 and V = 3.

Be sure to pick numbers that match the inherent aspect ratio of the video you 
are processing. For High Definition television video one uses numbers such as 
16x9 and 1 x .5625. For normal television video, numbers such as 1 x .75, 4x3 
and 8x6 work fine. For film, 16x9 is common. Using numbers that do not 
match the aspect ratio of the video being processed results in distorted video 
when rotated.

The status of Anamorph changes to match any effect that you load. Note, how-
ever, that Anamorph values are not keyframe attributes and you cannot change 
them within an effect. You can apply new Anamorph values to an existing work-
space effect. Dveous/MX re-scales all affected parameters as you enter 
Anamorph values. Simply re-save the effect to keep the Anamorph settings.

Blanking Width Compensation
Dveous/MX let you compensate for input video with overly wide blanking, 
which results in horizontal and/or vertical black edges on the input video. To 
adjust the blanking, go to the Input Setup menu and press the Channel softkey. 
Use Input to select the video source. Then select either Normal or Crop (A57) 
with the Blanking softknob. Adjust the horizontal and vertical edges with the H 
Blank and VBlank softknobs.
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Note that these adjustments apply only to video routed to the DVE channels 
and not to video selected as a background source.

Normal Mode  Allows you to set different blanking compensation for each 
input individually. Normal maintains a true aspect ratio for the image by 
stretching the aspect ratio of the input video so that the blanking edges are not 
visible. The advantage to this method is that each input can have its own blank-
ing compensation. The disadvantage is that the video is now stretched slightly, 
preventing you from transitioning or match-framing back to the original, 
unstretched image, either in Dveous/MX or in some external device, without 
seeing a visible difference between the two images.

Crop (A57)  Blanks all inputs by the same amount by simply cropping in the 
edges to remove the offending blanking areas. The advantage to this method is 
that all images maintain their original aspect ratios so there is no visible differ-
ence between the original and the cropped image, allowing match-framing 
between the two. A disadvantage to this method, however, is that blanking com-
pensation applies to all external inputs equally, and not individually.

Note: If you will be using Solid Builder to construct slabs and need to match unity size, you 
must use Crop (A57) mode.
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Motion Detect 
Among powerful Dveous/MX features is the sensitivity of its motion detector. 
Motion Detect looks at the amount of motion in the input video and uses this 
information to produce a clean image in later manipulations of size, location or 
rotation. Usually, Motion Detect's default setting will suffice, but depending on 
the kind of video you are bringing in, you may want to adjust settings when 
configuring Dveous/MX. 

Note: Due to the inherent technical nature of progressive (frame based) HD video formats, 
Motion Detection is not required. Therefore Motion Detect is only applicable when using 
interlaced HD video formats. If working in progressive HD formats, Motion Detection defaults 
to frame mode and the Mot Det menu has no effect on the video.

Note: Don't confuse the motion created by running an effect on Dveous/MX with motion in 
the input video. It is only the input video that the motion detectors are concerned with. An 
exception is that Dveous/MX border width changes are considered input video motion.

Frame Based Precision  To understand the power of Motion Detect, it is 
important to note that Dveous/MX is a frame based digital effects system: it 
uses a full frame (as opposed to a single field) of information when transforming 
the video to the size and position you define with the transform controls.

Transferring a full frame of video requires using information from two consecu-
tive fields. When motion exists in the video, the two fields can be different, 
since they are scanning at different time intervals. Trying to reconcile them into 
a single image can result in chaos. What you see on the screen is loss of picture 
quality or visible banding. Motion Detect eliminates these resolution problems 
by telling the system how much or how little motion to look for so that the 
fields combine into a clear image.

Accessing and Adjusting Motion Detect
To access Motion Detect, press the MULTI button on the Control Panel. The 
Multi menu appears. Press the Motion Detect function softkey to enable to Mot 
Det parameter.
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Mot Det
The Mot Det softknob lets you select one of sixteen settings. These settings rep-
resent a range of sensitivity to motion from low (frame) to high (field), and 
ranging from 1-14 in between. A low value causes Dveous/MX to treat the 
video as though it has less motion than is really present, and can cause banding 
artifacts in the motion portions of the video. A high value causes Dveous/MX to 
treat the video as though it has more motion than is really present, and can 
cause the picture to lose some detail. 

Varying Amounts of Motion in the Same Video
With Motion Detect, you can also deal with varying amounts of motion within 
the video by defining settings between frame and field, For example, in video of 
a car driving past an otherwise stable shot, Dveous/MX would use the frame 
mode on the static parts of the video, and the field mode on the parts that con-
tain motion, adapting the mode to the video.

Forcing frame mode
Sometimes it is useful to force frame mode. For example, if the still input video 
has a lot of noise. Dveous/MX can interpret noise as motion and the result is a 
too soft image. Setting Motion Detect to frame would compensate for the noise 
and clarify the image.

Forcing Field Mode
Sometimes it is useful to force field mode. It is possible for motion in the video 
(particularly when using animated computer generated graphics that contain a 
lot of the same color) to fool the system into thinking no motion has occurred. 
Select field in these cases to eliminate any artifacts you may see.

The Motion Detect Settings
Motion Detect's default setting is 9, which works well in almost all cases. Even 
with still video, this setting provides the best quality, since Dveous/MX auto-
matically enables frame mode if the motion detector finds no motion. 

Default:         9
Range:           Frame - 1 - 14 - Field
Align:            None

Note: The Personality menu's Film mode can override this setting. See the Film Mode text for 
details.
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Film Modes
There are two different issues dealt with in the Personality menu's Film mode: 
How to handle motion detection of incoming video (Mode) and how to transi-
tion between keyframes when running an effect (Motion). The two settings do 
not interact with each other, but are used in similar situations. Access these set-
tings by pressing the PERSONALITY button then the Film softkey.

Note:  Some film mode settings are not applicable on certain format selections of Dveous/MX.

Video Types
There are four types of video Dveous/MX may encounter:

nnnn Static Video - No movement in the video at all.

nnnn Field Based Video - Each field has the possibility of different video from the 
preceding and next field. This is the typical video produced by video 
cameras and such.

nnnn Frame Based Video - This is video that has motion only at frame changes; 
there is a frame of two identical fields (with respect to motion) followed by 
another frame with two more identical fields, with the possibility of motion 
occurring between the two frames. 

nnnn 3:2 Pull-Down Video - This is mostly a 525 function. The idea is to convert 
film's 24Hz frame rate to 525 video's 60 fields per second rate by alternately 
recording three or two fields for each film frame. The end result is a pattern 
of three identical fields followed by two, then three, etc.

Film Settings

Mode   The Mode setting determines how Dveous/MX should treat incoming 
video. It acts as an override to the Multi menu Motion Detect setting. 

Normal   With Mode set to Normal, the Multi menu Motion Detect setting 
controls how Dveous/MX interpolates two fields of video when creating the 
manipulated video output. 

Film  With Mode set to Film, Dveous/MX takes advantage of the fact 50% of 
the time the current field was preceded by an identical field (with respect to 
motion), and forces the Motion Detect setting to Frame. The other 50% of the 
2-13
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time it uses the actual Motion Detect setting. Set Phase to match the field dom-
inance of the video (1/2 frames or 2/1 frames).

3:2  With Mode set to 3:2, the Multi menu Motion Detect setting is ignored, 
forcing Field motion.

Note: While the Mode setting does affect the Multi menu Motion Detect function, there is no 
indication that this is happening when looking at its setting.

Keep in mind that none of these settings have an affect on the picture until you 
compress or expand it; at unity size the interpolator is inactive. Leaving Mode 
set to Film with incorrect video results in a venetian blind or tearing look to the 
video that is hard to miss.

The other thing to remember is that whatever you set this for, it applies to all 
channels and all video signals that are passing through them. This setting (like 
the other Personality settings) is not remembered as part of an effect.

Motion  The Motion setting controls how Dveous/MX creates the video in 
between keyframes when running an effect.

Normal  With Motion set to Normal, Dveous/MX creates 60 positions per sec-
ond (one per field) when running an effect.

Film  With Motion set to Film, Dveous/MX creates 30 positions per second (one 
per frame). The idea is to use this with frame based video so that the effect does 
not create any motion between two fields that are the same. Selecting Film 
causes a stuttering frame-based look when running an effect. The Phase setting 
is to ensure that Dveous/MX jumps to the next frame at the same time the video 
does, matching its field dominance. 

3:2  With Motion set to 3:2, Dveous/MX creates 24 positions per second (one 
per film frame). This works the same as the Film setting, with the exception that 
the Phase setting has five values. Choose one to exactly match the effect's run-
ning with the video's position in the 3/2 (five field) pattern.
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Delegating Channels
When you want to make changes to a channel, or to several channels, you have 
to delegate them first. You can have one, several or all channels delegated at 
once. Changes you make in a menu affect the delegated channel(s). Use the five 
red Channel Select buttons to delegate channels. Please refer to the graphic on 
the following page.

While not technically regarded as a channel, the GLOBAL button can also be 
delegated, since it has its own timeline. Delegate the GLOBAL “channel” when 
making changes in one of the Global menus.

One channel is always the Master channel. The channel you choose to be the 
Master will be one whose menu displays in the Control Panel. If you are only 
working on one channel, then that channel is automatically the Master and 
appears delegated as well. If you are working on more than one channel, one 
must be chosen as the Master. The Master does not have priority over the other 
delegated channels, but changes you make to the Master will affect other dele-
gated channels, all offsets being maintained.

Offsets Between Delegated Channels  All offsets between channels are main-
tained when entering changes to the Master channel. For example, let's say both 
channels 1A and 1B are delegated, with channel 1A designated as the Master. 
Channel 1B has a .25 Z rotate value, and Channel 1A has a .5 Z rotate value. 
Since 1A is the Master channel, the menu shows a .5 Z rotate value. Increasing 
the rotation value maintains the relationship of the two channels, and rotates 
them as a single unit. As a result, channel 1A always has .25 more rotation on it 
than 1B. 

Note:  Entering an absolute value with the keypad gives both channels identical rotations.

Note:  If GLOBAL is the only delegated channel, you will not be able to make any changes in 
any of the Channel menus. The same is true if none of the channels are delegated.
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How to Delegate Channels 
You can toggle any channel on and off after designating the Master, including 
the Master itself. There are four different methods of delegating channels:

• Pressing a channel button once reverses the previous delegation status. So, a 
channel that was undelegated becomes delegated when pressed once. Con-
versely, a delegated channel becomes undelegated. By default, channel 1A is 
the Master channel.

• Pressing a channel button once and holding it assigns that channel to Master 
channel status without changing the delegation of any other channel. For 
example, if channels 1A, 1B and 2A were delegated, and 2A was the Master, 
pressing and holding 1A would now designate it as the Master while leaving 
1B and 2A delegated. 

• Pressing a channel button twice assigns that channel as the Master channel 
while undelegating all other channels.

• Pressing a channel button twice and holding it delegates all channels, includ-
ing the Global channel and makes that channel the Master.

Note: If you are working with less than a dual twin system, the inaccessible channel buttons 
(1B, 2A or 2B) can be pressed but will appear as grayed out on the delegation menu. No func-
tions can be performed on these channels.

LOCATE
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-0.5000
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Copying Channel Settings
You can easily copy the current setup of the Master channel to all other dele-
gated channels. This method copies all menu settings for the Master channel to 
the delegated channels. 

1. Select the Master channel by double-pressing one of the Channel Select but-
tons.

2. Press the Channel Select buttons of the channels into which you want to 
copy the Master channel settings.

3. Press COPY CHANNEL.

4. Press ENTER. The settings of the Master channel are now copied to the 
delegated channel(s).

Channel Copying for Specified Menus  Instead of copying all menu settings 
for the Master channel, you can copy just those for specific menus (up to six at 
a time). After pressing COPY CHANNEL, press the menu button(s) whose 
Master channel settings you want to copy. Then press ENTER.
2-17
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As described in Section 1 – Introduction, each Dveous/MX twin channel can 
operate in three modes:

• Video+Video – two independent video channels.

• Video+Key – one video channel and an independent key channel.

• Video-Key+Shadow – also called SuperShadow; one video channel with a 
“slaved” key, and an independent shadow channel.

By definition, channel A is always video. The default configuration is two inde-
pendent video channels. If your system is a dual twin system (channels 2A and 
2B), you can configure one pair of channels differently from the other.

Note: If you have only one channel of HD, then the channel works in video only and the fol-
lowing configuration instructions are not applicable.

How to Configure Your Channels

1. Double press the 1A Channel Select button to configure the 1A/1B channel 
pair. Double press the 2A Channel Select button to configure the 2A/2B 
channel pair.

2. Press the KEY button to bring up the Key menu.

3. Press the Setup softkey to select it.

4. Use the Mode softknob to set the DVE board configuration:
V+V (Video+Video mode) sets the transform boards to process two indepen-
dent video channels.
V+K (Video+Key mode) sets the transform boards to process one video 
channel (A) with an independent key channel (B).
 VK+S (Video-Key+Shadow mode) sets the transform boards to process a 
video channel plus a slaved key (A) and an independent shadow channel (B).

In any configuration, you can select a near and far source for each channel, as 
described earlier in this section. 

Note: The softknobs under the Mode softkey do not appear in Video+Video mode, as both 
channels are forced to a full white key signal.
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Configuring Video+Key or Video-Key+Shadow
Continue with Step 5 if you have performed steps one through four on the pre-
ceding page and are choosing V+K or V-K+S modes.

5. Press the Mode softkey. For Video+Key mode, the Key softknob controls the 
key (B) channel only.

In Video-Key+Shadow mode, the Key softknob is for the key portion of the 
A channel, and the Shadow softknob is for the shadow (B) channel.

Both softknobs select the key mode for the channel:
White – a full raster key signal (i.e., a white field) that matches the size of 
the transformed video.
Video – generates a key signal based on the luminance in the source selected 
for the B channel.
Inv Video – same as Video, except that it inverts the polarity of the gener-
ated key signal (i.e., black changes to white and white changes to black).

Use Video or Inv Video when you want to replace the rectangular key with a 
shape (for example, the key signal from a character generator). Normally, 
use White in the Video-Key+Shadow mode when you want to derive a 
shadow from the normal rectangular raster.

6. Press the Setup softkey to bring up the Gain, Clip, and Phase controls for the 
keyer. For a full linear key, use the default values (Gain = 100 and Clip = 50). 
Gain adjusts the key edge sharpness. Clip is a threshold adjustment that sets 
the luminance level at which the key turns on or off.

Phase adjusts the horizontal position of the key signal relative to the original 
video. Use it to compensate for key timing errors that originate outside 
Dveous/MX. Normally, you can leave it at its default value (0.00).

Note: With White selected as the key source, the Gain, Clip, and Phase adjustments have no 
effect.
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Configuring Video-Key+Shadow
Continue with Step 7 if you are using V-K+S mode.

7. Press the Shadow softkey to access the color and opacity controls for the 
shadow channel. The Lum, Sat, and Hue softknobs adjust the shadow 
brightness, color saturation, and hue, respectively. The B Opac softknob sets 
a transparency value for the shadow. The default values for Lum, Sat, and 
Hue (0) and a B Opac value of about 50 yield a realistic looking drop 
shadow. You can also use the Input menu Blur softkey settings to soften the 
drop shadow for an even more realistic look.
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Getting Back to Default
There are two different default states you can reset: factory defined default val-
ues or your own, user-defined, default values.

• NORMAL (in the Timeline Effects Editor buttons) resets channel values the 
user defined settings.

• CLEAR (in the numeric keypad) resets factory-defined default settings. 

Using NORMAL

User-defined NORMAL Settings
User-defined Normals let you put all, or just parts of, a menu's settings to your 
preferred default settings. Using NORMAL commands, you can quickly set to 
your defaults. This feature is useful, for example, if you always want to reset to 
certain inputs. Or maybe you always want channel 1B squeezed down when 
you go the 3D Transforms, etc.

Setting Up and Modifying NORMAL Defaults
First, set all menu parameters to your preferred settings. Then:

• To set Normals for only delegated channels, press MODIFY –– NORMAL –
– ENTER. 

• To modify all channels, press MODIFY –– MODIFY –– NORMAL –– 
ENTER.

Using NORMAL to Reset the Normal Defaults
• To reset all parameters of the delegated channel(s) back to their user-defined 

settings, press NORMAL — ENTER. The delegated channels are reset to the 
personal-preference defaults that you entered.

• To reset all channels to the user-defined settings, press NORMAL — 
NORMAL — ENTER. All channels are reset to any personal preference 
defaults that you entered.

• To reset all channels to factory default, press NORMAL — NORMAL — 
NORMAL — ENTER.

Using CLEAR 
CLEAR resets to the factory default. 
2-21



2-22

Section 2: Getting Started

Start Here

Index

Contents
Before You Start
To reset values using CLEAR, the message <Clear> must first be displayed in the 
keypad buffer. Press CLEAR once to empty the keypad buffer of any pre-exist-
ing value. Once there is no value in the buffer, or if no value exists in the buffer, 
pressing CLEAR now inserts the message <Clear> into the buffer. Conditions 
are now set to do a reset to default value. 

• To reset an entire menu to default, hold CLEAR and press the menu button. 
For example, to set all 3D Trans menu parameters to default, press CLEAR + 
3D TRANS. All values for each menu function (3D Locate, Rotate and Axis 
Locate) are reset to factory default.

• To reset all of the parameters for a function, hold CLEAR then press the 
function softkey. For example, to clear the parameters associated with the 
Locate function in the 3D Trans menu, press CLEAR+Locate. All values for 
each parameters, H Loc, V Loc and Z Loc, are reset to default.

• To reset a single parameter, press CLEAR and the keypad softkey (A, B, C or 
D) for the softknob whose parameter and motion path type you want to reset. 
For example, to clear the H Loc parameter under Locate in the 3D Trans 
menu, press CLEAR+ the A button. You can clear one or more parameters 
using this method.

• Set the entire machine back to factory default
You can also reset the entire machine to the factory default (as shipped from 
Accom), regardless of channel delegation. Press NORMAL — NORMAL — 
NORMAL — ENTER. Even though you are using NORMAL, this com-
mand clears to factory default.

Note:  Performing the CLEAR function does not affect the status of battery backed RAM. See 
“First Birthday” in Dveous/MX Technical Guide, P/N 9100-0402-00, for information on 
RAM reset.
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The Numbering System

SD Mode
Dveous/MX in the SD mode uses a numbering system derived from the nor-
mal television aspect ratio of 4:3 – four units horizontally by three units verti-
cally. Dividing both sides of this ratio by four yields 1:3/4, or 1:0.75. The SD 
mode uses this ratio as its numbering system. It indicates that the horizontal 
width of the screen, or the H axis, is one unit; the vertical height of the screen, 
or V axis, is three quarters of a unit, or 0.75 units. There is plenty of room for 
moving the image in both the Source and Target spaces (see Section 3 – Trans-
forms for a discussion of Source and Target space); all planes have H and V 
dimensions of 200 units, or 200 times the height and width of the screen.

The third dimension, Z, is perpendicular to the H and V dimensions on each 
plane: it runs straight into and out of the plane at right angles to the horizontal 
and vertical directions. This value indicates depth, or distance from the next 
downstream plane. 

The axis of each plane is defined as a point at which all three dimensions (H, V, 
and Z) have values of 0.0000. A point to the left of the axis on the plane has a 
negative H value; the left screen edge has an H value of -0.5000. A point to the 
right of the axis has a positive H value; the right screen edge has an H value of 
+0.5000. This gives a total width of 1.000.

Similar coordinates apply to the vertical dimension. A point above the axis has a 
positive V value; the top screen edge has a V value of +0.3750. A point below 
the axis has a negative V value; the bottom screen edge has a V value of -0.3750. 
The vertical range from screen edge to screen edge gives a total screen height of 
0.7500.

The H and V position numbers may represent locations on the Source plane 
beyond the limits of the screen; the numbers always give you the exact location 
of the image on the plane, even if it is not visible in the video output.

In two dimensional transforms, the Z value represents picture size on the Source 
plane; it does not move the image in the Z (distance) direction. A value of 
1.0000 gives a full size image. 0.5000 indicates that the horizontal and vertical 
dimensions of the image are reduced to one half of full size, and the image area 
is one quarter of full size (1/2H x 1/2V = 1/4).
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In three dimensional transforms, the Z value represents the position of the 
image relative to the next downstream plane: its distance from it. At a value of 
0.0000, the image's Z position image coincides with the plane; it is “sitting” on 
the plane. At values above 0.0000, the image is “behind” the plane, i.e., further 
away from the viewer. At negative values, the image is “in front of” the plane, 
i.e., closer to the viewer. At Z values equal to or less than -1.6667, the image dis-
appears; it has moved past the eye's viewing point and is actually “behind” the 
viewer in 3D space.

Moving the axis (for either the Source or Target plane) moves the rotational cen-
ter of the plane relative to the image. You can move the image, including the 
axis, on the plane (using the locate controls) or move the axis only, leaving the 
image alone (using the axis locate controls), or move the image only, leaving the 
axis alone (using the 2D Trans Pre controls).

HD Mode
Dveous/MX in the HD mode uses a numbering system derived from the high 
definition television aspect ratio of 16:9 – sixteen units horizontally by nine 
units vertically. The HD mode uses this ratio as its numbering system. It indi-
cates that the horizontal width of the screen, or the H axis, is sixteen units; the 
vertical height of the screen, or V axis, is nine units. There is plenty of room for 
moving the image in both the Source and Target spaces (see Section 3 – Trans-
forms for a discussion of Source and Target space); all planes have H and V 
dimensions of 3200 and 1800 units, or 200 times the height and width of the 
screen.

The third dimension, Z, is perpendicular to the H and V dimensions on each 
plane: it runs straight into and out of the plane at right angles to the horizontal 
and vertical directions. This value indicates depth, or distance from the next 
downstream plane. 

The axis of each plane is defined as a point at which all three dimensions (H, V, 
and Z) have values of 0.0000. A point to the left of the axis on the plane has a 
negative H value; the left screen edge has an H value of -8.0000. A point to the 
right of the axis has a positive H value; the right screen edge has an H value of 
+8.0000. This gives a total width of 16.000.

Similar coordinates apply to the vertical dimension. A point above the axis has a 
positive V value; the top screen edge has a V value of +4.5000. A point below 
the axis has a negative V value; the bottom screen edge has a V value of -4.5000. 
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The vertical range from screen edge to screen edge gives a total screen height of 
9.0000.

The H and V position numbers may represent locations on the Source plane 
beyond the limits of the screen; the numbers always give you the exact location 
of the image on the plane, even if it is not visible in the video output.

In two dimensional transforms, the Z value represents picture size on the 
Source plane; it does not move the image in the Z (distance) direction. A value 
of 1.0000 gives a full size image. 0.5000 indicates that the horizontal and verti-
cal dimensions of the image are reduced to one half of full size, and the image 
area is one quarter of full size (1/2H x 1/2V = 1/4).

In three dimensional transforms, the Z value represents the position of the 
image relative to the next downstream plane: its distance from it. At a value of 
0.0000, the image's Z position image coincides with the plane; it is “sitting” on 
the plane. At values above 0.0000, the image is “behind” the plane, i.e., further 
away from the viewer. At negative values, the image is “in front of” the plane, 
i.e., closer to the viewer. At Z values equal to or less than -26.6667, the image 
disappears; it has moved past the eye's viewing point and is actually “behind” 
the viewer in 3D space.

Moving the axis (for either the Source or Target plane) moves the rotational cen-
ter of the plane relative to the image. You can move the image, including the 
axis, on the plane (using the locate controls) or move the axis only, leaving the 
image alone (using the axis locate controls), or move the image only, leaving the 
axis alone (using the 2D Trans Pre controls).
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The Numeric Keypad
Use the numeric keypad to enter values for menu functions. 

The Keypad Buffer
The keypad buffer always appears in the lower right corner of the menu display 
and shows the value or function ready to be applied to a menu setting. Entering 
a value in the keypad puts the number in the keypad buffer. The other buttons 
in the numeric keypad let you apply functions to settings. The list below shows 
the buttons and their functions.

Entering Values
This section tells you how to enter, clear, align, and trim, numeric values. It also 
covers copying values from one setting to another, and assigning motion path 
types to parameters.

Using the Keypad Softkeys (A,B,C,D)

Use the keypad softkeys (A, B, C and D) to enter values for one of the four 
function parameters. The keypad softkeys correspond to the parameters from 
left to right, A belonging to the leftmost softknob and so on. Simply enter a 
value for the parameter, then press its corresponding keypad softkey.

For example, look in the 2D Trans menu under the Position/Pre function. The 
Size setting is the right-most parameter, so its corresponding keypad softkey is 

 Button Function Buffer Message

PATH Selects the parameter motion path type.
(Also used in disk menu to select or highlight more than one file)

<Set Path> 
JP LN SL T1 T2 SM

ALIGN Sets the parameter to the closest 1/8th of full range. 
(Also used in disk menu to select or highlight all files)

<Align>

TRIM Adds or subtracts the entered amount to/from the current value. <Trim>

CLEAR If a number or function is in the buffer, this erases it; If nothing 
is in the buffer, this resets the parameter to default. This button 
also clears entries in the Keyframe Edit Dialog area.

<Clear>

+/- Inverts numeric values, and sets trims to subtract.
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D. To enter a value of .5 for Size, enter .5 in the numeric keypad, then press D. 
The image shrinks to one half full size, horizontally and vertically. 

Copying Values

You can copy values from one parameter to another, or from a parameter in one 
menu to a parameter in another menu. 

First, make sure the keypad buffer is empty (press CLEAR to clear any existing 
values). Then, press the parameter's keypad softkey (A, B, C or D) to copy its 
value and motion path type into the keypad buffer. You can then press another 
keypad softkey in the current menu or in another menu to enter this value and 
motion path type in another softknob.

Also, make sure that the keypad buffer does not display before pressing A,B,C 
or D. When displays and you enter a value then press A,B,C or D, you are clear-
ing that parameter to default. You may need to press CLEAR twice to ensure 
that the keypad buffer is completely empty. 

For example, the Size setting has a value of 0.5000. Pressing the D button loads 
0.5000 into the keypad buffer. Now pressing B sets the H softknob to 0.5000.

Inverting Values +/-

Use the +/- button to invert the number in the keypad buffer. To enter a nega-
tive value, you can either enter the value followed by the +/- key, or press +/- fol-
lowed by the number value. For example, if softknob A has a value of 5, pressing 
+/- then A changes the softknob value to -5. Conversely, if the value is -5, press-
ing +/- inverts the value to 5.

Maximizing or Minimizing a Setting

If you want to quickly set the highest or lowest allowable value for a parameter, 
enter a value that is outside its range, then press its keypad softkey. Dveous/MX 
automatically sets the value to its minimum or maximum setting. For example, 
entering 1000 in the Size softknob sets it to 99.9999.

Trimming Values

You can change an existing value, or “trim” it, by adding or subtracting a given 
amount to or from it. To trim a parameter value, press the TRIM button to 
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enter the message in the keypad buffer. Then, enter the trim amount in the 
numeric keypad and press a keypad softkey. For example, to add 1.5 to the value 
in softknob A press TRIM — 1.5 — A. To subtract 1.5 from the value in soft-
knob A, enter TRIM — +/- — 1.5 — A or +/- — 1.5 — TRIM — A.

Note that there is always a trim amount in the keypad buffer. On bootup, the 
default trim amount is +1. After you trim a value, the keypad buffer remembers 
the trim amount. Now when you press TRIM, the keypad buffer recalls the last 
trim amount used. This feature makes it easy to trim multiple values by the 
same amount.

Aligning Values

You can use the ALIGN button to reset an existing parameter value to the near-
est one-eighth of the full range of that parameter. This command is handy if you 
have used the softknob or the joystick to roughly position the image, then want 
to position it more accurately. For most settings, the typical value is a one eighth 
increment. With rotations, for example, one eighth of a complete rotation is 45 
degrees or 0.1250. Aligning a rotation value of 1.1111 resets it to 1.1250, the 
nearest multiple of 0.1250. Locate settings use one eighth of a screen unit as the 
logical value. For example, aligning an H locate value of 3.4739 sets it to 3.5, 
which is the nearest multiple of 0.1250, or one eighth of a screen unit.

For other functions, where there is no typical value, the align function sets the 
value to the closest one eighth of the parameter's entire range. For example, in 
the Multi menu, the full range for mosaic tile size is 0 - 100. Since the typical 
value is a multiple of 12.5000, or one eighth of the entire range, aligning a tile 
size of 28.3267 changes it to 25.0000, a multiple of 12.5000.

Assigning Motion Path Types
Motion paths define how Dveous/MX interpolates from the settings in one key-
frame to the settings in the next. Use the PATH button to assign motion paths 
to keyframeable parameters. See Section 7 – Motion Control for more details on 
each motion path type.

When you press the PATH button, this message appears in the keypad buffer:

<Set Path>
JP LN SL T1 T2 SM

The letters across the bottom indicate the available path types:
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JP Jump (Hold)
LN Linear
SL Smooth Linear
T1 TCB1 (Tension, Continuity, Bias preset 1)
T2 TCB2 (Tension, Continuity, Bias preset 2)
SM Smoothed Motion

Some parameters take only certain path types. If you try to assign an invalid 
path type to a parameter, the system assigns the highest "priority" path type 
available to it. The “priority” follows the list in the keypad buffer, left to right 
from lowest to highest. For example, if you try to assign SM to a parameter that 
takes only the JP, LN or SL path types, it assigns SL instead, because that is the 
highest priority path type allowed for that setting.

Methods of Assigning Path Type  The highlight indicates the currently 
selected path type. Pressing the PATH button cycles the highlight through the 
list and selects a path type. 

• To assign to a single parameter, select a path type, then press the keypad soft-
key (A,B,C or D) associated with the parameter. The path type abbreviation 
appears next to the parameter value.

• To assign the same path type to all the parameters related to a single menu 
function, select a path type and hold the PATH button, then press the menu 
softkey associated with that function.

• To assign a path type to all the parameters in a menu, select a path type and 
hold PATH, then press the menu button on the Control Panel. 

Note: When assigning a path type to multiple settings, remember that the path “priority” rule 
applies to any setting that does not accept the path type you want to assign.

Remembering Last Used Path  The keypad buffer “remembers” the last path 
type selected, making it easy to assign the same path type to many parameters. 
After you assign a different path, the next time you press PATH, the keypad 
buffer recalls the last path type used. When you boot up, the default path type is 
T1. 

Note:  When changing paths to an existing effect, you must first modify the effect before run-
ning the new PATH parameters.
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The joystick lets you quickly adjust one or more of a menu's parameter settings. 
It gives you immediate visual feedback when positioning images, widening a 
border, playing with warps, etc.

If the joystick can be used in a menu you will see arrow icons in the function 
parameter display, next to the parameter's name. As you use the joystick to 
adjust the image, the values for that parameter change as well. 

    Move the joystick up or down to see that parameter change.

    Move the joystick left or right to adjust that parameter.

    Twist the joystick to see adjust that parameter.

Locking the Joystick to a Menu

You can tie, or lock, the joystick control to a menu's function parameters. After 
going into joystick lock mode in one menu, you can go into another menu and 
adjust its parameters by using the parameter softknob, while adjusting the 
locked parameters with the joystick. This feature is handy, for example, if you 
want to rotate the image using 3D Trans menu controls while playing with warp 
shapes in the Warp menu.

Press JOYSTICK LOCK on the Control Panel before leaving a menu. The joy-
stick lock non-standard mode indicator status message displays. 

Joystick Tricks

Applying Your Own Directional Arrows

In some menus, no directional menus appear, which indicates the joystick is not 
available for use. However, you can sneak around the system and temporarily tie 
the joystick to any unmarked parameters you wish. To do so, hold down the 
unmarked parameters corresponding keypad button (A, B, C, or D) while mov-
ing the joystick horizontally or vertically or by twisting it. Whichever way you 
first move the joystick determines the direction you tie to the parameter, and 
that directional arrow will appear in the parameter's menu display.

Joystick Lock Sneak Peek

When in joystick lock mode, you can easily find out what parameters you tied 
the joystick to in the other menu. Simply press and hold the JOYSTICK LOCK 
button. The menu display will change to show the menu, functions, and param-
eters that you were in when the joystick was locked. When you release the JOY-
STICK LOCK button, the menu reverts to its previous display. 
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Creating a Simple Effect
Now that you know how to select a source and delegate channels, let's create a 
few simple effects. These effects are broken down as follows and become parts of 
one larger effect:

• Building an effect on Channel 1A

• Modifying the effect on 1A

• Creating an effect on Channel 1B

• Moving both channels in tandem

• Non-unity lights

Building an Effect on Channel 1A
In the following exercise, we will squeeze the picture down in size, move it 
around the screen, and rotate it 360 degrees.

1. Press DELETE — DELETE –– ALL — ENTER in the TimeFrame Effects 
Editor to clear any existing keyframes from all channels, in the event an 
effect was hiding somewhere.

2. Press NORMAL — NORMAL — NORMAL — ENTER to clear all menu 
settings to the factory default. Default mode selects the Video+Video mode, 
and gives channel 1A keying priority over channel 1B.

3. Double press the 1A Channel Select button to delegate it and undelegate the 
other channels. 

4. Press the 3D TRANS menu button. The 3D Trans menu appears.

5. Press the Locate softkey and toggle it to Source.

6. Twist the joystick counterclockwise to make the image smaller. Or, you can 
turn the Z Loc softknob counterclockwise. The smaller channel 1A appears 
keyed over a full-size channel 1B.

7. Move the reduced image to the upper left corner of the screen with the joy-
stick or with the H Loc and V Loc softknobs.

8. Press the INSERT NEXT button. The current parameters are now stored as 
keyframe 1.

9. Move the image to the upper right corner of the screen using the joystick or 
softknobs. Press INSERT NEXT again to store the new parameters as key-
frame 2.

10.Move the image to the lower right corner of the screen. Press the Rotate soft-
key and toggle it to Source.
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11.Rotate the image a full 360 degrees around its Z axis by entering the value 1 
for Z Rot. To do this, enter 1 in the numeric keypad, then press the C key-
pad softkey. Press INSERT NEXT to store the current parameters as key-
frame 3.

12.Press Locate and move the image to the lower left corner of the screen. Press 
Rotate and rotate the image horizontally by moving the joystick left or right. 
(You can also use the H Rot softknob.) To rotate the image exactly 180 
degrees, enter .5 in the numeric keypad, then press the A keypad softkey. As 
the image rotates past “edge-on,” the back source appears. Press INSERT 
NEXT to store the current parameters as keyframe 4. There is now a four 
keyframe effect in the workspace.

13.Press the RUNllll button to run the effect. The image starts at the upper left 
corner, moves to the upper right corner, rotates about its center while mov-
ing to the lower right corner, and rotates to reveal the back side while moving 
to the lower left corner of the screen. Press kkkkRUN to run the effect from the 
last keyframe to the first. Press PAUSE at any point to pause the effect, then 
press RUNllll or kkkkRUN to resume running the effect from that point. Press 
START to rewind the effect to the beginning.

Note: This effect is based on motion paths set to linear.

Modifying an Effect

To change the current effect, you can modify any parameter as follows:

1. Move to the keyframe you want to change by pressing NEXT (to step for-
ward to the next keyframe) or PREVIOUS (to move back to the previous 
keyframe).

2. Change a parameter and press the Quick Keyframes MODIFY button. This 
modifies only the current keyframe. (For now, do not use the MODIFY but-
ton in the TimeFrame Effects Editor.)

3. Run the effect by pressing RUNllll. The effect now runs with the modified 
keyframe.
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Creating an Effect on 1B

So far, you have created and modified an effect for channel 1A only. To create an 
effect for channel 1B, double press the 1B button to delegate that channel and 
undelegate channel 1A. Then, using the above procedure as a guide, create a 
different effect for channel 1B.

When you create the effect for 1B, it will start running at the last keyframe you 
were on in the previous effect. So, if you run 1A to the end and don't rewind it, 
when you create 1B's effect, it will start after 1A runs its last keyframe. If you 
rewind 1A, before starting to build 1B's effect, then 1B will start when 1A 
starts, and both channels will simultaneously run their own effects.

Moving Both Channels in Tandem

You can also create an effect with both channels moving in tandem. Remember 
that Dveous/MX looks at what channels are delegated when it determines 
which channels to affect. So, to move 1A and 1B in tandem, they must both be 
delegated. Also, remember that one channel must always be delegated at the 
Master Channel. The Master Channel has no greater importance than any 
other, but just tells Dveous/MX which timeline to look at and whose menus to 
display.

1. Double press the 1A channel select button to make it the Master and to del-
egate it.

2. Press the 1B channel select button to delegate it.

3. Adjust parameter settings in the 3D Trans menu. Both channels will be affect 
equally, with all offsets maintained.

Non-unity Lights
The LEDS on the menu buttons are called non-unity lights. When lit, they tell 
you that a menu's parameters have been changed. The menu is no longer in 
default, or unity, state. This feature is handy as a quick reference to figure out 
what menus you have worked in and what menus are affecting the image.
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Saving Effects
The place where effects are saved is called the effects register. You can store up to 
100 effects in the register. Effects are numbered 0 through 99. Each effect can 
have a maximum of 300 keyframes. The keyframes for each effect come from a 
collected pool of keyframes in battery backed up RAM (a semi permanent stor-
age device). There are over 1700 keyframes in memory. When you create an 
effect, the system sets aside a portion of these keyframes for that effect.

Note: Each delegated channel's timeline uses a keyframe from the system pool. This means that 
when you create an effect by inserting four keyframes into five channels (1A, 1B, 2A, 2B and 
Global), you actually use 20 keyframes from the pool.

Saving an Effect
You can quickly save effects to the register without having to enter a menu.

1. Enter an effect register number (0 - 99) in the numeric keypad.

2. Press the SAVE EFFECT on the Control Panel. The effect is now saved at 
that number in the register and its number displays next to Current Effect.

Overwriting Existing Effects 
Depending on whether you have enabled the protect flags, one of two things 
happen if you try to overwrite an existing effect:

Protect Flag Not Enabled  If the existing effect does not have the protect flag 
enabled, the workspace effect overwrites the one in the register. You will not be 
prompted that you are overwriting an existing effect.

Protect Flag Enable  If the existing effect does have protect enabled, 
Dveous/MX does not save the workspace effect, and does not overwrite the 
existing effect. A prompt tells you that the register is protected.

Recalling an Effect
There are two ways to recall effects: recall directly from the Control Panel, or 
recall from within the Effects menu.
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Recalling from the Control Panel  

1. Enter an effect register number (0 - 99) in the numeric keypad.

2. Press the RECALL EFFECT button the Control Panel. The effect from that 
register loads and its number displays as the Current Effect in the menu's 
workspace display.

Recalling from the Effects Menu  

1. Press RECALL EFFECT. The Effect menu appears.

2. Use the REG# parameter softknob to dial in the number of the effect you 
want to recall. Although the effect's number appears in the Workspace dis-
play as the Current Effect, the effect will not load until you press RECALL 
EFFECT.

3. Press RECALL EFFECT. The effect is now loaded in the workspace.

Modifying a Recalled Effect  When you make changes to the currently loaded 
effect, an asterisk displays next to Current Effect in the menu display. The aster-
isk is a friendly reminder that you have changed the effect. The changes are not 
saved, however, unless and until you press SAVE EFFECT. 

Workspace as the Current Effect  When the word WorkSpace displays as the 
Current Effect, you are creating a brand new effect that has not been saved yet. 
Or, you have deleted all keyframes from all channels, in effect starting over 
again.

Note: See Section 8 – Saving and Recalling Effects for complete information about recalling 
effects and for information about using the disk drives to archive and recall effects.

LOCATE
Target Source

LOCAL 3D TRANSFORMS Ch 1A
CURRENT TIME: 6.00     CURRENT EFFECT:22* REMAINING KFs: 300

KF# H LOC V LOC Z LOC

Gb
1A
1B
2A

The asterisk indicates you have
made changes to effect 22.
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The Effects Menu
Use the Effects menu to browse the effects registers, enable/disable the effect 
loop and protect flags, name effects, and delete effects. Access this menu by 
pressing the RECALL EFFECT button in the Effect area of the Control Panel. 

Reading the Display  For each effect register, the menu shows how many key-
frames exist in each channel and the status of the Loop and Protect modes. Look 
at Remaining KFs to know the total remaining keyframes available in the system 
pool.

Reg #   Use the Reg# softknob to scroll through the effect registers and view 
what numbers you have saved to. You can also use the joystick to move through 
the register, or go to an effect directly by entering its number in the keypad, 
then pressing A in the keypad register.

The Loop and Protect Flags
You can enable/disable the loop and protect flags for an effect in an on-line reg-
ister as follows. Note that you can set the Workspace effect to loop, but you can-
not enable the protect flag for it.

Enabling/Disabling Loop and Protect  

1. Use the Reg# softknob or the joystick to highlight an effect register number. 
Or you can enter the number into the keypad and press A on the keypad reg-
ister.

2. Turn the Loop and Protect softknobs to the desired status (on or off ) for that 
effect register.
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Deleting Effects
Only unprotected effects can be deleted. You can delete the current effect, or all 
effects, so long as they are unprotected, from the register(s) as follows. To delete 
an effect in a protected register, first use the Protect softknob to turn the regis-
ter's flag off. 

1. Use the Reg# softknob or the joystick to highlight the effect number to be 
deleted. Or you can enter the effect's number in the keypad and press A in 
the keypad register.

2. Press Delete Effect. Select is highlighted.

3. Press Delete Effect again to confirm the deletion. A message appears to indi-
cate the effect register has been deleted, and all channels show 0 keyframes 
at that register.

Note: You cannot delete the workspace effect in this manner. To delete the workspace you must 
use the Timeframe Effects Buttons (DELETE—ALL—ENTER).

Note: For complete information about saving, naming and deleting effects, please see Section 8 
– Saving and Recalling Effects.
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